Georgia State University

Banner 8x Basic Navigation

Training Documentation
Questions regarding information in this documentation can be e-mailed to the Banner Training Team at bantrain@gsu.edu

The training website is at www.gsu.edu/bantrain, from this site

Click on Banner Help to access the Banner Help page

Click on GoSOLAR Account to access information on how to request a Banner ID

Click on Documentation to download GSU Banner documentation.
The Documentation link is password protected.
User Name = gosolar
Password = pounce
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning Objectives</td>
<td>4</td>
</tr>
<tr>
<td>Banner Structure</td>
<td>5</td>
</tr>
<tr>
<td>Banner Form Naming Conventions</td>
<td>6</td>
</tr>
<tr>
<td>Logging in to Banner</td>
<td>8</td>
</tr>
<tr>
<td>The Banner General Menu Window</td>
<td>10</td>
</tr>
<tr>
<td>Accessing Help Functions</td>
<td>18</td>
</tr>
<tr>
<td>Navigating within Banner</td>
<td>19</td>
</tr>
<tr>
<td>Parts of form</td>
<td>19</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>20</td>
</tr>
<tr>
<td>Populating the form with data</td>
<td>20</td>
</tr>
<tr>
<td>Navigating among blocks within a form</td>
<td>21</td>
</tr>
<tr>
<td>Navigating within a block</td>
<td>22</td>
</tr>
<tr>
<td>Navigating between forms</td>
<td>23</td>
</tr>
<tr>
<td>Object Search, Calendar and Calculator</td>
<td>23</td>
</tr>
<tr>
<td>Indicators and Iconic Buttons within Banner forms</td>
<td>24</td>
</tr>
<tr>
<td>Avoiding Duplicate Records in Banner</td>
<td>26</td>
</tr>
<tr>
<td>Using Wildcard Symbols to Search</td>
<td>26</td>
</tr>
<tr>
<td>Querying in Banner</td>
<td>28</td>
</tr>
<tr>
<td>Performing a search in a query form</td>
<td>29</td>
</tr>
<tr>
<td>Viewing detail information</td>
<td>30</td>
</tr>
<tr>
<td>Performing a search in a query form using Soundex</td>
<td>31</td>
</tr>
<tr>
<td>Performing a search in the key block</td>
<td>32</td>
</tr>
<tr>
<td>Customizing a key block extended search</td>
<td>34</td>
</tr>
<tr>
<td>QuickFlow</td>
<td>35</td>
</tr>
<tr>
<td>Creating a Personal Menu</td>
<td>38</td>
</tr>
<tr>
<td>Changing your Oracle Password</td>
<td>39</td>
</tr>
<tr>
<td>Accessing Electronic Documentation</td>
<td>40</td>
</tr>
<tr>
<td>Exiting Banner</td>
<td>40</td>
</tr>
<tr>
<td>Best Practices and Tips When Using Banner</td>
<td>42</td>
</tr>
<tr>
<td>Conclusion</td>
<td>43</td>
</tr>
<tr>
<td>Appendix A: Banner Navigation Mapping Sheet</td>
<td>44</td>
</tr>
<tr>
<td>Appendix B: Glossary of Banner Terms</td>
<td>45</td>
</tr>
<tr>
<td>Appendix C: Naming Conventions</td>
<td>47</td>
</tr>
<tr>
<td>Appendix D: Answer key for Review</td>
<td>50</td>
</tr>
</tbody>
</table>
Learning Objectives

At the end of this training, you will be able to:

✓ Describe Banner structure
✓ Describe the naming conventions
✓ Log in to Banner
✓ Describe the parts of the General Menu Window, including the Menu Bar, Tool Bar, Title Bar, information blocks and Auto Hint line
✓ Describe and access Help functions
✓ Access forms in Banner
✓ Describe the parts of a Banner form
✓ Navigate Banner forms, blocks, and fields
✓ Avoid creating duplicate records
✓ Perform query in Banner
✓ Create QuickFlow and Personal Menu
✓ Set Up User Preference
✓ Change your Oracle password
✓ Access electronic documentation
✓ Exit Banner
I. Banner Structure

We'll begin by explaining a little about Banner structure. Banner uses series of forms in an Oracle database to enter and retrieve information. A Banner form is similar to a paper form, except information is entered once and then it is available to be used by other users and by other forms, reports and jobs.

A. Systems, Menus and Modules

Each system consists of related forms that are grouped into lists called menus, and menus are grouped together into submenus known as modules in Bannerland. Georgia State University uses four systems: General, Student, Financial Aid, Georgia Enhancements.

General System
The forms under the General system functions allow the user to generate letters, personalize Banner functions, manage Banner system functions and run a variety of batch processes.

Student System
The Student system supports a wide range of student administration functions that are grouped into different modules such as Catalog, Registration, and Accounts Receivables.

Financial Aid System
The Financial Aid system gathers and processes financial aid information.

Georgia Enhancements System
The University System of Georgia created the Georgia Enhancements system, general known as the Georgia Modifications (GA Mods). The menus and forms in this system are related to Georgia-specific functions.

B. Types of Forms

Banner uses six types of forms to enter and access information - Application, Validation, Rule, Control, Query, and Inquiry.

Application Forms
In general you'll be using Application Forms to enter and update Banner information. The other types of forms help you find the information in the specific Banner format you need to fill in the Application Forms.

Validation Forms
Validation Forms allow you to create and update a list of values that can be entered in specific fields on Application Forms. Many fields can only use specified values found in the list of values on a Validation Form.
Rule and Control Forms
Rule and Control Forms show information that affects processing on other forms. They also provide a means for each institution to customize and set up Banner according to institution-specific policies and procedures.

Query Forms and Inquiry Forms
You'll use Query Forms and Inquiry Forms to look up information that already exists in the Banner database. These forms will often then add that information to the field you accessed them from. You can access Query or Inquiry Forms directly or from within another form.

II. Banner Form Naming Conventions
Forms are the means with which all information in Banner is entered, maintained, edited, and queried. The names of Banner forms, reports, processes, and tables are seven characters, with each character representing a position location as well as reflecting its origin and function.

Let's use the Person Identification Form - SPAIDEN - as an example. The first letter (position location 1) identifies the system that owns the form. This form is part of the Student system, so it begins with S. The second letter (position location 2), P, indicates the application module that owns the form. This form is part of the Person module. The third letter (position location 3), A, identifies the type of form as an Application form. Finally, the last four letters (position location 4 – 7) are a four-character name for the specific form. In this case, IDEN indicates that this is the Identification form.

<table>
<thead>
<tr>
<th>Position Location Assignments</th>
<th>Position Location</th>
<th>Example</th>
<th>Character Representations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifies the <strong>system</strong> owning form</td>
<td>1</td>
<td>S</td>
<td>Student System</td>
</tr>
<tr>
<td>Identifies the <strong>module</strong> owning the form</td>
<td>2</td>
<td>P</td>
<td>Person Module</td>
</tr>
<tr>
<td>Identifies the <strong>type of form</strong></td>
<td>3</td>
<td>A</td>
<td>Application Form</td>
</tr>
<tr>
<td>Identifies a unique four character abbreviation of form description</td>
<td>4</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>N</td>
<td></td>
</tr>
</tbody>
</table>

For more information on Banner Naming Conventions, please refer to Appendix C as well as the Banner online documentation. In the online documentation, naming conventions is listed within the Student System under the SCT Banner Student section Ch 2.
Review

1. In which system will you find the form to personalize banner functions such as creating your Personal Menu and changing password?

   a  Alumni
   b  General
   c  Student
   d  Financial Aid
   e  Georgia Enhancements

2. Banner uses six types of forms to enter and access information. Which of the following forms would you use to enter and update Banner information?

   a  Validation Forms
   b  Application Forms
   c  Rule Forms
   d  Control Forms

3. You learned that the Banner system has a seven character name that reflects its origin and function. From the following, choose the most accurate statement about the seven character code:

   a  The first and second letters indicate the application module that owns the form.
   b  The third and fourth letters identifies the type of form.
   c  The last four letters are an abbreviation for the specific form.
   d  The first five letters identifies the system that owns the form.
III. Logging in to Banner

Now that you are familiar with the basic Banner structure, let’s log in to Banner and take a closer look.

1. Open your web browser and go to the GoSOLAR portal http://www.gosolar.gsu.edu. The GoSOLAR portal is a webpage where employees can easily access INB, Web for Student, Web for Faculty and other GoSOLAR system related links.

2. Click on the Internet Native Banner (INB) link under the Administrative Tools section. This will take you to http://inb.gosolar.gsu.edu. From inb.gosolar.gsu.edu, click on BPROD to logon.
   Please note: Internet Native Banner requires Internet Explorer 7.X or Mozilla Firefox (any version below 3.0).

3. If you want to log on to BLAB for practicing purposes, click on the Training Portal. From the BLAB GoSOLAR portal, click on Internet Native Banner will take you to http://inb.blab.gosolar.gsu.edu where you can log on to BLAB.

4. Before you log on for the very first time via INB, you must download the 1.6.26 JRE. The download should initiate automatically when you clicked on the database name. Please follow the instructions provided by the install wizard.
   If you have pop-up blocker turned on, you will need to hold down the CTRL key from the keyboard before clicking on Internet Native Banner for the JRE download to show.

5. The Banner log on screen will appear next. Log on with your CampusID and CampusID password and click Connect or press Enter on the keyboard.

7. The Banner main window will then appear.

8. When Banner is running, there will be two buttons on the task bar. Internet Native Banner Form Services is needed to run Banner. Oracle Developer Forms Runtime is Banner. The server number is randomly assigned and will be displayed on the Internet Native Banner Form Services button.

9. To log off Banner via INB, you must first perform the **Exit function** in Banner. Then close the Developer Server and Oracle JInitiator browser window as well as the INB Form Services browser window to which it shows the server you are assigned.
IV. The Banner General Menu Window

After the SCT Banner screen, the General Menu window will appear and it is the starting point for navigating throughout the system. The General Menu window looks like this:

Here are the features of your Banner Main Window:

1. **Top Blue Bar**
The top blue bar shows you that this web browser is the “Oracle Developer Forms Runtime – Web” indicating that this is your Banner session.

2. **Menu bar**
The Banner Menu Bar, located at the top of every form, contains pull-down menus. You can access an option in a pull-down menu at any time, except when you are in the midst of working with a dialog box, alert box, or List of Values (LOV). If a pull-down menu name is grayed out, the menu is disabled and cannot be accessed.

Banner Pull-down menus work in typical Windows fashion:
1. Click the desired pull-down menu name. Menu item choices appear.
2. Click the desired menu item.
Pull-Down Menus

For your reference, what follows is a description of what you’ll find in each of the various Pull-Down Menus accessible from the Menu Bar, working from left to right:

File Menu
This pull-down menu contains standard Banner and Oracle functions. The bottom of the menu lists the last 10 forms you have accessed in your current session. You can return to any form in this list by simply clicking on its name.

Some of the menu items let you call another form, job, or QuickFlow. When you exit the called object, you return to the object you were previously using.

Direct Access Displays the Go To Field, which is used to access a form by its seven-character name.

Object Search Displays the Object Search Form (GUIOBJS), which is used to search for a menu, form, job, or QuickFlow with part of the name, description, or type.

QuickFlow Displays the QuickFlow Form (GUAQFLW), which is used to access a QuickFlow.

Select Returns you to the calling form and enters the selected value into the field that called the form.

Rollback
On Application and Inquiry forms
Clears all information (except key information) and returns the cursor to the first field in the key block.

On Validation forms
Returns the cursor to the first field on the form.

On Query forms
Returns the cursor to the first field on the form.

Save Saves all changes entered since the last time you saved.

Refresh Clears the message line.

Print Prints the current window with the date and time in the title bar.

Exit
On forms and windows
Exits you from the form or window.

On General Menu window
Exits you from Banner.

In Query mode
 Cancels the query and takes the form out of query mode.

Exit QuickFlow Exits you from a QuickFlow.
Preferences Displays the Personal Preferences Maintenance Form (GUAUPRF), which you use to customize your view of Banner.

List of recently accessed forms Lets you quickly re-access forms that were previously accessed in your current session (up to ten).

**Edit Menu**
This pull-down menu contains the functions used to edit text items.

- **Cut** Cuts selected text and places it on the clipboard.
- **Copy** Copies selected text to the clipboard.
- **Paste** Pastes text from the clipboard to the spot where the cursor is located.
- **Edit** Displays the Editor window, which is used to enter or update text. You can display this window from most fields. It is particularly useful in long data fields.

**Options Menu**
This pull-down menu contains navigation options.

In INB the Options menu can be accessed via the Options pull-down menu. The Options menu provides a way to navigate the Banner forms and blocks. Clicking on an option in the Options menu will take you to that block or form.

Options change as the cursor location changes. Some options take you to other blocks and windows within the current form. Other options take you outside the current form to other related forms.

**Note:** Using the Options Menu will cause Banner to open forms upon forms. This will cause the Banner system to become unstable. Please use the Options Menu with caution. It is best to exit the current form and go back to the General Menu window before accessing another one.

**Block Menu**
This pull-down menu contains the functions used to navigate among the blocks of information on a form.

- **Previous** Moves the cursor to the previous block that has at least one enterable field. If the previous block is in another window, that window is opened.
- **Next** Moves the cursor to the next block that has at least one field where data can be entered or edited. If that area is in another window, that window is opened.
- **Clear** Clears all information from the current block on your display. (Information is not removed from any records or tables.)
**Item Menu**

This pull-down menu contains the functions used to navigate among the fields on a form.

- **Previous** Moves the cursor to the previous enterable field in the current block.
- **Next** Moves the cursor to the next enterable field in the current block. Occasionally, *Next Field* moves the cursor to the first enterable field in the next block.
- **Clear** Clears all information from the current field on your display. (Information is not removed from any records or tables.)
- **Duplicate** In a blank row of a repeating record, copies the contents of the same field in the previous record into the new record.

**Record Menu**

This pull-down menu contains the functions used to work with records on a form.

- **Previous** Moves the cursor to the first enterable field in the previous record.
- **Next** Moves the cursor to the first enterable field in the next record of the current block. If the cursor is in the last record, a new record is created.
- **Scroll Up** Scrolls up the list of repeating records, putting the first displayed record near the bottom of the list.
- **Scroll Down** Scrolls down the list of repeating records, putting the last displayed record near the top of the list.
- **Clear** Clears all information from the current record on your display. (Information is not removed from any records or tables.)
- **Remove** Removes all information for the current record. When you Save, the removed information is deleted.
- **Insert** Inserts a new blank record into the list of existing records.
- **Duplicate** Duplicates the contents of all fields in the record and copies them into a new record.
- **Lock** Temporarily locks the contents of the record so no other Banner user can update it. Save, Rollback, and Exit release the lock.

**Query Menu**

This pull-down menu contains the functions used to query information in the database based on specified criteria.

- **Enter** Puts the form into query mode so you can enter search criteria to see what information is already in the database.
Execute

Searches the database and displays the first set of records that match your search criteria.

Last Criteria

Enters the criteria from your last search (enabled only when you are in Query mode).

Cancel

Cancels the query and takes the form out of Query mode.

Count Hits

Counts the number of records that match the search criteria and displays that number in the Auto Hint line.

Fetch Next Set

If more records meet the search criteria than fit in the window, replaces the current set of displayed records with the next set.

Tools Menu

This pull-down menu contains actions that can be performed with Banner Xtender Solutions.

Help Menu

Provides electronic access to hardcopy Sungard Banner documents

Online Help

Dynamic Help

Query

Displays the Dynamic Help Form (GUAHELP) in query mode, which is used to display help for a field, block, or form.

Dynamic Help

Edit

Displays the Dynamic Help Form (GUAHELP) in edit mode, which is used to edit traditional help for a field, block, or form.

Help (Item Properties)

Displays the Oracle item properties window for the current field.

Show Keys

Displays the Keys list, which lists the functions and their equivalent keystrokes available for the current form, window, and field.

List

Displays the List of Values (valid entries for the current field) if one is available.

Display Error

If an Oracle error occurs, displays the code that is in error.

Display ID Image

If the cursor is in an ID field, displays the image associated with the ID, if available.

Calendar

Displays the calendar.

Calculator

Displays the calculator.

Extract Data with Key

Allow data extract with Key block information if data extract function is set up.
Extract Data No Key  Allow data extract without Key block information if data extract function is set up.

Technical Support  This sub-menu provides access to SQL Trace, optimization mode, and database reconnection features.

Turn SQL Trace On  Turns the SQL Trace feature on. SQL Trace is a tool that helps your technical support staff track performance issues that need to be resolved.

Turn SQL Trace Off  Turns the SQL Trace feature off. SQL Trace is a tool that helps your technical support staff track performance issues that need to be resolved.

Set Query Optimizer to All Rows  This cost-based optimization mode is recommended for testing batch processing. Rather than immediately populating the cursor, this option optimizes the query to get the best time for the entire results set to be displayed. Because of this, it is a good option for batch processing rather than online processing.

  Note: You must be connected to an Oracle10g database in order to use this option.

  Warning: Changing optimization modes mid-session may cause your results to be invalid due to cached data from previous queries. SunGard SCT recommends that you exit and re-enter Banner if want to change optimization modes.

Set Query Optimizer to First Rows  This cost-based optimization mode optimizes the query to get the first set of rows as quickly as possible. It is useful for online processing. DBAs can configure how many rows will be defined as the “first rows,” for example, 1,100, 1000.

  Note: You must be connected to an Oracle10g database in order to use this option.

  Warning: Changing optimization modes mid-session may cause your results to be invalid due to cached data from previous queries. SunGard SCT recommends that you exit and re-enter Banner if want to change optimization modes.

Set Query Optimizer to Rule  This standard rule-based mode is based on sql and database schema, and optimization is based on Oracle rules in the database (for example, if an index is present, then use it). It does not optimize queries, but rather executes them based on a series of Oracle rules.

  Note: You must be connected to an Oracle10g database in order to use this option.

  Warning: Changing optimization modes mid-session may cause your results to be invalid due to cached data from previous queries. SunGard SCT recommends that you exit and re-enter Banner if want to change optimization modes.
Reconnect to Database
Reconnects to the database.

About SCT Banner
Displays the *About SCT Banner* Form (GUAABOT), which identifies the current form, release number, date, and time.

Window Menu
This pull-down menu lets you arrange the open windows of a form.

- **Cascade**
  Displays open windows in a cascade format.
- **Tile**
  Displays open windows in a tiled format.
- **Arrange Icons**
  If an open window is collapsed into an icon, lets you move the icon.

3. Tool bar

4. Title bar
The title bar tells you the menu, form or block name as well as the database and the current Banner version that you are using.

5. Collapse Menu within the Hierarchical Menu
When the folder is closed, the menu is collapsed. To collapse an expanded folder, double click on the open folder.

6. Expanded Menu within the Hierarchical Menu
When the folder is opened, the menu is expanded. Double click on a closed folder to expand the menu. The expanded menu displays the contents of the menu selected. Note: The menu that is currently selected is highlighted.

7. Auto Hint line
The Auto Hint line is located at the very bottom of the Banner window. It provides brief information about a field the cursor is in. It may be about the purpose of the field, what you can do next, or how to move to another window or form. Error messages will also appear in this area.

```
field description
keyboard equivalents:
LIST to display codes
COUNT HITS to display paragraph codes
DUPITEM to display letter codes
Paragraph Code, press LIST for codes, COUNT HITS Paragraph, DUPITEM Letter.
Record: 1/7 | | | | List of Values | | <ESC>
```

**Note:** This Help line is very important as it displays information about the current form and the actions you are performing. If Banner does not seem to be functioning as you expected, refer to this line for help. It is likely that an error message is being displayed.
8. Status line
The status line is directly beneath the Auto Hint line message area. Examples of some Status line messages are shown below.

- **Record 1/?**
  Indicates there is more than one record. You need to use the up and down arrow key to view the records.

- **List**
  If List appears, then the field has a required set of values. Double Click on the field to pop up the List Of Values (LOV).

- **Enter query**
  If Enter query appears when you enter the form, it means the form is already in query mode and is ready to perform a search function.

9. Go To Field
You can use Go To Field to access a menu, form or job by entering its seven-character name. You can use Go To Field from the General Menu Window or select Direct Access from the File Drop pull-down menu from within a form.

*To use Go To Field from the General Menu Window:*
1. Enter the seven-character name of the menu, form or job in the **Go To field** (see General Menu Window screen on page 10).

2. Press <Enter>.

*To use Direct Access/Go To Field from a form:*
1. From the *File* pull-down menu on your menu bar select *Direct Access*. The Go To Field appears.

2. Enter the seven-character name of the form, job, or QuickFlow in the **Enter a valid name** field.

3. Click the <Start> button or press <Enter>.

**Note:** When you use Go To Field from a form, the current form remains open. When you exit the requested form, job, or QuickFlow, you return to the original form.
V. Accessing Help Functions

Help is available from any form. There are four types of help – Help (Item Properties), Dynamic Help, Bubble Help and Auto Hint. You can get to Help and Dynamic Help from the Help menu on the Pull-down Menu Bar. Bubble Help and Auto Hint are available on the screen.

1. Help (Item Properties)   Help shows how a data field is defined. For example, it lets you know the data type required (i.e. character or numeric) and the maximum data length of the field that your cursor is in. It will also show you the name of the Validation Form, if there is one, behind that field.

2. Dynamic Help   Dynamic Help describes the function and use of a form or field. You can go directly to Dynamic Help for a specific field by placing your cursor in the field, holding down the Shift key and double-clicking.

3. Tool Tips   When you move your cursor over buttons and pause, a tool tip appears with text that describes the function of the button.

4. Auto Hint Line   As we discussed earlier, Auto Hint at the bottom of the screen gives you descriptions and tips about fields and information blocks, as well as error information.

Review

1. There are four kinds of help available in Banner. Which type of help gives you descriptions and tips about fields and information blocks, as well as error information?
   
   a. Help Menu  
   b. Dynamic Help  
   c. Bubble Help  
   d. Auto Hint Line  

2. On the Banner form, where can you find information on the menu, form or block name as well as the database and the current Banner version that you are using?
   
   a. Tool Bar  
   b. Status line  
   c. Title bar  
   d. Pull-down menu  

Banner 8 Basic Navigation 18
VI. Navigating within Banner

The vast majority of your work in Banner will be done in the forms. These are the screens where you actually enter and retrieve data from the system. Go to form SGASTDN for an example of a Banner form.

A. Parts of form

The window you are looking at is your main window, where the form data is located. The main window is divided into sections, or blocks. Blocks are often separated from one another by boxes and lines on the form.

- A key block does not have a title.
- If a form or window has only one block, the block does not have a title.
- If a form has a key block and only one other block, the second block has no title.

Key Information block
The first block is called the key information block, sometimes referred to simply as the key. (Some forms, especially validation forms and certain list forms, do not have a key block.) The key is the first thing to appear on most Banner forms and is the deciding factor for the data that appears on the rest of the form. All the information that is displayed on the form is driven by the information that you enter in the key.

The key block has at least one field and sometimes more. For example SHATERM, the form that displays student academic history, have key block fields for student id, student level and term code.
The key block stays on the form as subsequent blocks appear. Occasionally, another window may appear on top of the key block if the window is unusually large or if the key block is not pertinent to the window.

**Note:** To navigate back to the Key block of the current form, click on the  <Rollback> button or use the  <Shift+F7> key function.

**Other Blocks**

Other blocks contain additional details for the key information. Each block contains related information and is usually enclosed in a beveled box.

**Tool Bar**

There is a Tool bar across the top of the form and main menu from which you can select functions. The Tool Bar icons also behave just like the toolbar in Word or Excel. When you hold your cursor over a Tool Bar icon, the function of that icon will appear.

**B. Populating the form with data**

There are several ways to populate a Banner form; in other words, see what data is in the form.

- If you are a **mouse** user: put your cursor in an enterable **field** (one where your cursor turns from an arrow into an I-bar) and click.
- If you are a **keyboard** user:  <Ctrl+Page Down> (hold down the Ctrl key and the Page Down key). This is the key function for <Next Block>.
- If you are a **Tool Bar** user: click the **Next Block icon** in your Tool Bar.
- If you are a **pull-down menu** user: click the **Block pull-down menu** and choose the **Next** option.
C. Navigating among blocks within a form

Tabs
Certain forms feature a tabbed interface. Tabs are used to arrange information in a meaningful way, and allow you to navigate easily between groups or blocks of information. Tab titles reflect the contents of a particular window or grouping of information. For tabbed forms that contain windows of parent/child information, the main (“parent”) tab appears in the top row. The dependent (“child”) information appears on tabs lower on the window and below the top-level tab to which the information is related. The majority of forms in Banner contain blocks. Blocks contain information of the form that is layered underneath the main window.

For example, the SGASTDN form has a total of eight blocks. There are eight tabs across the top of the block:
- Learner
- Curricula
- Activities
- Veterans
- Comments
- Academic and Graduation Status, Dual Degree
- Miscellaneous

You can access your blocks of information a number of different ways:
- If you are a mouse user: Click on the one of the “Tabs” across the top of the block.
- If you are a keyboard user: use the <Ctrl+Page Down> key function will bring up the first block. Repeat to bring up successive blocks.
- If you are a Tool Bar user: click the Next Block icon in your Tool Bar. This will bring up the first block. Repeat to bring up successive blocks.
- If you are a pull-down menu user: click the Block pull-down menu and choose the Next option. This will bring up the first block. Repeat to bring up successive blocks.
D. Navigating among fields within a Block

Information within a block is stored in fields. Each of the white rectangular spaces in the blocks is called a field. You have some choices about how you move from field to field within a block, you can

- Use the Tab key on the keyboard to move from one field to another within a block
- Place the cursor in an enterable field and click. An enterable field is where the pointer turns into an ‘I’ beam.

Note: If you are stuck in an enterable field because you do not want to enter any data in the field and Banner keeps prompting you that “Field must be entered or deleted first”, click on the Field pull-down menu and select Clear or click on the Record pull-down menu and select Clear or Remove to get out of the blank enterable field.

Some blocks are in scrollable windows. These scrollable windows are similar to the ones you see in Word or Excel. Most of the time scrollable window within a block means there is more than one record within the same block. You can move from record to record within a block by

- Placing your cursor on a scroll button and moving it
- Clicking on the arrows at the ends of the scroll bars
- Using the Up and Down arrow keys on the keyboard
E. Navigating between forms

You have some choices about how you move from form to form.

Go To Field from General Menu window
From the General Menu window, you can enter the seven-character form name in the Go To field. If you are in a form, exit the form you are currently in, either by clicking the <Exit> button or using the <Ctrl+q> key function, will take you back to the General Menu window. You may have to hit <Exit> several times if you have moved into a number of forms in succession.

Direct Access from the File pull-down menu
Choosing Direct Access will bring up a selection box on your screen where you can type the name of the form you need into the selection box and hit <Enter> or click the <Start> button. This will bring up the new form.

File pull-down menu
The bottom of the File pull-down menu lists the last 10 forms you accessed. You can select any form in this list to re-access it.

F. Quick Tips – Object Search, Calendar and Calculator

Here are a couple of additional Banner tools that will help you get information quickly.

Object Search
You can use Object Search to access a form, job, or QuickFlow if you know part of its name, description, or type.

To use Object Search:
1. From the General Menu Window, click on the Down arrow (Search function) next to the Go To field, or from any form, click File pull-down menu and choose Object Search.
2. Enter your search criteria on the GUIOBS (Object Search Form). You can use any or all of the Name, Description, and Type fields. You can use the wildcards % and _ to perform the search. (For more detail on how to search, see Using Wildcard Symbols to Search, page 24.)

3. <F8> to Execute Query. A list of all matches appears.
4. Scroll to the desired name.
5. Double-click the desired name or click the <Start> button.
Calendar
If you double-click in any **date field**, you'll get a calendar. Click on the date that you want entered in the field, then on OK. The date will be entered in the field in the proper Banner format.

**Tip for entering today's date in a date field** – type the letter ‘t' in the field and tab out of the field will populate today's date in the field.

Calculator
Double-clicking in any **numeric field** opens a calculator. You can use the mouse and/or number keys on the keyboard to make calculations. When you're done, click the OK button to return the calculated value to the field.

G. Indicators and Iconic Buttons within Banner forms
We'll go to the SPAPERS (General Person form) to look at some of these indicators and iconic buttons.

1. The **Radio button** is used to select one of several options in a group. You can only pick one radio button in a group.

2. The **Checkbox** is used to enable or disable features or options. When an option is enabled, a check mark appears in the checkbox. When the option is disabled, the checkbox is empty.

3. The **Down Arrow Search button** next to a field indicates the Search function is available for the field. The Search function displays another form or window to search for a value or information related to the field. It also displays a list of valid value for a field.
Review

1. Name the four different methods you can navigate among blocks within a Banner form.

   ___________________________  ___________________________
   ___________________________  ___________________________

2. The down arrow (Search) button indicates that the field:
   
   a  is an enterable field    
   b  is a required field     
   c  has a list of value or can be used to perform a search 
   d  has no value

3. If you want to go back to the key block of the form, you would use:
   
   a  the Exit button         
   b  the Rollback button    
   c  the Save button        
   d  hold down the control key and press page up

4. The down arrow next to a field indicates that the field:
   
   a  is an enterable field   
   b  is a required field    
   c  has a list of value or is searchable 
   d  has no value
VII. Avoid creating duplicate records in Banner

When you are entering new person or non-person information in BANNER, it is critically important that you perform a thorough query/search of the database BEFORE entering the information. This is to make sure that the person or non-person does not already have a record in the system.

Serious problems arise when duplicates are created. For example, student records can be exist on multiple IDs. This will create trouble for Student Accounts, Financial Aid, and Registrar because registration and course history could be fragmented among the duplicates – no one ID would have the complete student record. This makes the correct billing and granting of Financial Aid impossible. It is very difficult to detect duplicate records until they cause a problem, and we want to preserve as much data integrity on the front end as we can.

The rule of thumb to follow is that you should always assume that the person or non-person you need to enter already has a record in BANNER. Your job is to find that record using all available search methods; only after a thorough query has been conducted should you enter the new record.

**Note:** Please follow the steps provided in the Thorough Person Search training documentation to perform a thorough search before creating IDs in Banner.

**Note:** When entering a new record, please refer to the GSU Data Entry Standard and Guidelines.

VIII. Using wildcard symbols to search

The % is the key to a successful name search. % is a wildcard - use it freely. Whenever there is any possible question in the spelling or structure of a name, use the %. For example, the name O'Brien may have been entered in a variety of ways. Use the % in any questionable situation. This name should be searched by O%rien. Keep this in mind for all Mc_, Mac, O', and Di_ and other names of this type.

International names present a unique challenge. Use the % freely! Try all permutations of all the names provided. Sometimes it is not clear which name(s) should be first and/or last. If you’ve entered what you think is the correct name, ID number, or SSN, but the system fails to find the person you need, do not assume that the person does not have a record in the system.

Banner is very picky about the way you query for information in the database, and a query feature called wildcarding will help you find the record you need. You can use these wildcard symbols when querying in both the key block and in query forms. The two wildcard symbols are % (percent) and _ (underscore). Both stand for any character; the difference is that % stands for any amount of characters, whereas _ can only stand for one character. You can use wildcards in a number of ways. For example:

- All entries that begin with Ab = Ab%
- All entries that contain ab = %ab%
- All entries that have ab as the final two characters = %ab
- All entries that have b as the second character = _b%

Banner 8 Basic Navigation
1. Before entering a new person, you need to do the following except:
   a. assume that the person you need to enter already has a record in BANNER
   b. conduct a thorough query
   c. enter a new record for the new person immediately
   d. refer to the GSU Data Entry Standard and Guidelines

2. You are unsure of the correct spelling of a last name when doing a search, but you know that the first three letters are "Smi". Which of the following is the best way to use the wildcard character in this instance?
   a. $Smi
   b. Smi%
   c. Smi$
   d. %Smi

3. When looking at an application form, the third character is not legible. Which of the following is the best way to use the wildcard characters in this instance?
   a. M_ap
   b. M%ap
   c. Map_
   d. Ma_p
IX. Querying in Banner

One of the most useful features of Banner is the ability to query. Querying is the process of looking to see what information is already entered in Banner. You can use inquiry forms, query forms, and most application forms to perform queries.

Some forms automatically open in query mode, usually because a large number of records would have to be retrieved. When a form opens in query mode, “Enter Query” appears in the status line. You can immediately specify search criteria to narrow the search.

**Query Functions**

Use the following functions to perform queries:

- **Enter**
  - Puts the form into query mode so you can enter search criteria to see what information is already in the database. “Enter Query” appears in the status line.

- **Execute**
  - Searches the database and displays the first set of records that match your search criteria. This function is enabled only if you are in query mode.

- **Last Criteria**
  - Enters the criteria from your last search. You can change any of the criteria. This function is enabled only if you are in query mode.

- **Exit or Cancel**
  - Cancels the query and takes the form out of query mode.

- **Count**
  - Counts the number of records that match the search criteria and displays that number in the auto hint.

- **Fetch Next Set**
  - Replaces the current set of displayed records with the next set of records if more records match the search criteria than fit in the window. This function is enabled only if you are in query mode.

---

**A few notes about querying**

- Capitalization matters. Data is matched against the search criteria exactly as you enter them.
- To clear a query and enter a new one, select **Enter Query icon** from the Tool Bar.
- To exit a query form when it is in a query mode, you need to click the **Exit** button twice. Once to exit the query function and then again to exit the form.
- If you have not selected a record after your query, and wish to execute another, you can perform two Enter Query functions in a row, and Banner will retrieve the last set of query criteria you executed.
In the following section, we are going to concentrate on “Person Search”. There are two ways to perform “Person Search” in Banner: doing a search in a dedicated query form and doing a search within a key block.

A. **Performing a search in a dedicated query form**

You have the option of performing a search in a dedicated query form. The most common dedicated query form in the Student module is SOAIDEN, shown below.

1. Click on the **<Search icon> button** from the ID field to access the Person Search Form (SOAIDEN).

2. SOAIDEN is already in a query mode, which means it is ready for you to enter your search criteria. If you know the name of the person you need, Type the last name in Last Name field and the first name in the First Name field.

3. **Execute query** function searches the database and displays any records that match the search criteria. You have several options in terms of performing the query itself:
   - If you are a **Tool Bar** user: click the **<Execute Query> icon** in the Tool Bar.
   - If you are a **keyboard** user: use the **<F8>** key function.
   - If you are a **pull-down menu** user: click on the **Query pull-down menu** and choose **Execute**.

4. When you have executed the query, the search results will populate in SOAIDEN. More than one row may appear if changes have been made to the person’s name or ID. The “Chg” column indicates the changes. N=Name change and I = ID change.

---

**Note:** In **SOAIDEN** the most effective way to search is to use the non case-sensitive search function. The "Case Sensitive Query?" is defaulted to the ‘No’ radio button at the bottom of the query form.
i. 

**Viewing Detail Information**

After the search results populated in SOAIDEN, you have the option to view detail information for a particular person found by the search.

1. Click once on the **ID number** for the person you want to view additional information.

2. From the Options pull-down Menu, click **Search and Display More Detail**.

3. The Person Search Detail Form (SOAIDNS) will appear. <F8> (Execute query) to populate the form with the information for the person selected.

4. After you confirm the person’s information, click the <Exit> button or <Ctrl+q> again to leave the Person Search Detail Form (SOAIDNS) and return to the Person Search Form (SOAIDEN).

5. Double-click on the ID number to select and bring the ID number back to the calling form.
ii. Performing a search in SOAIDEN using Soundex

If you are unsure of the correct spelling of the name, you can perform a search using the Soundex option from the Person Search Form (SOAIDEN).

1. Click on the <Search icon> button from the ID field to access the Person Search Form (SOAIDEN).

2. Click the <Exit> button or the <Ctrl+q> function to cancel the Query Mode.

3. From the Options pull-down menu, click Searching Using ‘Sounds Like’ to access the Soundex Search window.

4. Enter the information in the Last Name and/or First Name fields. (Text is case sensitive).

5. <F8> (Execute query). The Person Search Form (SOAIDEN) will return listing all records that match your search criteria.
B. Performing a search in the key block

The second way to perform “Person Search” in Banner is to perform a search in the key block. Follow these steps to perform a query in the key block of a given form:

1. Put your cursor in the **key ID field**. If there is an ID number currently in the field, hit **Delete** or choose **Clear** from your **Field** pull-down menu to clear the ID out of the field.

2. When the ID field is clear, hit your **Tab** key. This will put your cursor in the Name field.

3. If you know the first and last names of the person you want, type them in the Name field using lastname, comma, space, firstname protocol. Example: **Doe, Jane**. Hit the **Return** key. If there is only one person in the database with that last and first name, the Name field will automatically populate with the person’s name and ID number.

4. If there is more than one person with that name in the database, the **Extended Search dialog box**, shown below, will pop up. Its main function is to provide you the ability to narrow the search.

   ![Extended Search Dialog Box]

   *Use this arrow to view as well as to close the list of matching records.*

   *This is the number of records your search produced.*

   *Use these fields in this block to further narrow your search.*

   **Note:** The Extended Search results are based on the list of records that matched the INITIAL search criteria only.
Here are the features available in the Extended Search dialog box:

- Click on the pull-down arrow next to the blued-out **Search Results** field to pull down a list of records that matched your search criteria. You can scroll through this list using your mouse and the **scrollbar** or by using your **up and down arrow keys**.

  **Note: The indented records are previous IDs.**

- If you find the record that you want in this list, **double-click** or hit <Enter> with the record highlighted to bring it back to your form.

- If you cannot find the record you want from this list, close the list. To close the list, either click on the **blank row** with your mouse or hit **Tab** with the blank row highlighted.

- If you want to narrow the extended search list, **Tab** or click in one of the additional search criteria fields. You can narrow the list by entering a city, state, ZIP code, gender, SSN, or date of birth. Click the **<Search icon>** button or the **<F8>** (Execute Query) key function.

- If you have successfully narrowed your search, you'll see the number of records reduced. You can now scroll through the new list to identify the record you need.

- If your search reduction is unsuccessful, the word **Default** will appear in the Search Results field. To return to your previous list, click the **Rollback** button on the Extended Search dialog box.

- To exit the Extended Search dialog box without selecting a record, click the **<x>** on the ID and Name Extended Search Title bar.
i. Customizing a key block extended search in a query form

If you have performed a search in the key block, which produces a good number of matching records in the Extended Search dialog box, you can use the query form to better manage your search.

1. In the Extended Search dialog box, click the **Person Search Detail button** (the yellow folder). This will take you automatically to SOAIDEN and populate the query form with the search you've already performed (you may need to wait a few moments for the search to populate).

2. Using the **<Enter Query>** button or the **<F7>** key function to enter a query. A dialog box, shown below, will pop up. Click the **Extend your current query** button to customize your search.

Your query form will clear. Now, you can enter further criteria, such as part of an SSN, to further narrow your search. When you've entered the new criteria, **<F8>** (Execute query). The narrowed results (if any) will now show in the query form.

---

**Notes:** In SOAIDEN, you can decide whether you want a search to be case-sensitive or not by clicking in the "Case Sensitive Query?" Yes or No radio buttons at the bottom of the query form.
X. QuickFlow

Users from the supervisory/managerial level can set up QuickFlow to make data entry easier for the department’s work procedures. QuickFlow is a group of forms that are linked together into a chain. Once the QuickFlow is set up, users can access any QuickFlow they desired. When you activate the QuickFlow, it opens the first form in the chain. When you exit that form, the next form automatically opens.

A. Setting up QuickFlow

To set up QuickFlow, you must create a validation code (maximum 4 characters) and a description for your group of forms. After a validation code is created, you must define which forms you want to group together into a chain.

Creating a QuickFlow Validation Code

1. From the Go To field, type GTVQUIK to access the QuickFlow Code Validation Form.
2. Create a new QuickFlow code by using the <F6> (Insert Record) function.
3. Type the new code under the QuickFlow column.
4. Tab to the Description column and type the desired code description.
5. <Save> the record.

Note: A code can only be used once. If the code you want to use already exist, you must name your QuickFlow with another code.
Defining forms for QuickFlow

The easiest way to define your forms for a QuickFlow is to list the desired Banner 7 characters form names for your procedure before you access GUAQUIK.

1. From the Go To field, type GUAQUIK to access the QuickFlow Definition Form.
2. Type the QuickFlow Validation code in the QuickFlow field.
3. <Next block> and type the first form in the group by entering the Banner 7 characters form name in the Form Name field in the Current forms window.
4. Use the <Arrow down> key to go to the next record to enter the second form in the group.
5. Repeat step 4 until all the desired forms are entered.
6. <Save> the record.

Note: You can edit the list of forms in your QuickFlow.

To delete a form from your QuickFlow, click on the desired form name and click on the Delete Record icon.

To add a form to your exist QuickFlow, click on the desired form name and click on the Insert Record icon. This will give you a blank line in order to type in a new form for your QuickFlow.
B. Using QuickFlow

1. From the Pull-down menu bar, Select **File** and then select **QuickFlow** or use the Go To Field and type GUAQFLW to display the QuickFlow form.

2. Type the QuickFlow code in the **QuickFlow field**.

3. Select the <Start> button or press <Enter>.

4. Enter and <Save> data on the form.

5. <Exit> the form. The next form in the QuickFlow will appear.

6. Repeat steps 4 and 5 for each form in the QuickFlow. After you pass through all the forms in the QuickFlow, the GUAQFLW Form reappears.

**Exiting the QuickFlow**

To exit the QuickFlow before all the forms are accessed, select **File** and then select **Exit QuickFlow**.

**Note:** If you do not have any data to enter on a particular form within the QuickFlow, Exit the form. A message may appear on some forms asking whether you want to exit the form, click Yes.

If you want to access a particular form while you are in QuickFlow, Select File and then Select Go To Field to enter the Banner 7 characters form name.
XI. Creating a Personal Menu using My Banner Maintenance Form (GUAPMNU)

The easiest way to create your personal menu is to list the desired Banner 7-character form names on a piece of paper before you access GUAPMNU. You can also right click on a form in non-field area to display available options to add a form to your Personal menu while viewing the form. In order for your Personal Menu to become effective immediately, you must exit the Banner system and log on again. When your Personal Menu is all set, you can access it by clicking on My Banner from the Product Links and at the top of the hierarchical

1. Type in GUAPMNU in the Go To field.
2. In GUAPMNU forms will appear on the left and your user ID will appear in a box on the right.
3. Click on the Name column and type the form name.
4. Use the <Arrow down> key to go the next line and enter another form name.
5. Repeat steps 3 and 4 until all the form names are added to the menu.
6. <Save> the record.

If you want to choose the form names from the form column on the left instead of typing the form names, you need to:

1. Scroll through the forms or perform a query for form names on the left.
2. Highlight the form that you would like in your menu.
3. Click on the <Right arrow> button on the form.
4. Repeat steps 1 through 3 until all the form names are added to the menu.
5. <Save> the record.
XII. Changing Your Password

1. Go to the CampusID website at: https://campusid.gsu.edu/index.cfm
2. Click the Change your CampusID password link
3. Follow the instructions to reset your password.

Please Note: Resetting your CampusID password will affect logging into systems other than INB.
XIV. Accessing Electronic Documentation

At Georgia State, you can get additional Banner information (in the form of Adobe Acrobat® PDF files that can be searched) by clicking on the Banner Bookshelf link from the Main Menu or by going to the Banner documentation online. Go to www.gsu.edu/bantrain and click on the documentation link. The link is password protected. Username is gosolar and password is pounce. Click on Sungard Banner documentation. An Acrobat Reader® window appears that lists each Banner module. Click the name of the module to see the table of contents, then click on the topic you want to see.

XV. Exiting Banner

To exit the Banner system completely, from the General Menu Window click the <Exit> button and the dialog box will appear as below:

![Exiting Banner Dialog Box](image)

Click the <No> button or press N to cancel the exit and continue working. Click the <Yes> button or press Y to exit the Banner system. After you exit the system, a gray browser window will appear. Close the gray browser window by clicking on the X button on the right hand corner of the browser window.

---

**Important Note**

- **Closing the browser window does not log off your Banner session. This will create a hang session for user and may cause the lock down of student data displayed on a Banner form prior to closing the browser.**

- **Banner session is programmed to time out if it is not used in an hour. If you are not planning to use Banner for an hour or more, please exit the system.**

- **It is best to exit the current form and always go back to the General Menu window before accessing another form.**
1. Name two ways to perform “Person Search” in Banner.

   ______________________________________

   ______________________________________

2. Which Banner form will display detail information on one of the Person Search results?
   a  Person Search Form
   b  Identification Form
   c  Person Search Detail Form
   d  ID and Name Extended Search Form

3. What is the main function of the Extended Search feature in which the Extended Search results are based on the list of records that matched the initial search criteria?

   ______________________________________

4. Why do you need to click the Exit button twice in order to exit a query form?

   ______________________________________

5. Where do you access on-line documentation from Banner?

   ______________________________________
Best Practices and Tips When Using Banner

➢ To avoid locking up data, it is best to exit the current form and always go back to the General Menu window before accessing another form. Remember one form at a time!

➢ Using the Options Menu will cause Banner to open forms upon forms. This will cause the Banner system to become unstable. Please use the Options Menu with caution. It is best to exit the current form and go back to the General Menu before accessing another one.

➢ Closing the browser window does not log off your Banner session. This will create a hang session for user and may cause the lock down of student data displayed on a Banner form prior to closing the browser. Please use the Exit button from the General Menu Window to exit Banner. See page 40 for detail information on how to exit Banner.

➢ Banner session is programmed to time out if it is not used in an hour. If you are not planning to use Banner for an hour or more, please exit the Banner system.

➢ When your Personal Menu is all set, you can access it by clicking on My Banner. See page 38 for Personal Menu set up information.

➢ The Auto Hint line is your friend as it displays information about the current form and the actions you are performing. If Banner does not seem to be functioning as you expected, refer to this line for help. It is likely that an error message is being displayed.

➢ When you report a Banner problem, please include the server number which is located on the Internet Native Banner Form Services window. See page 9.

➢ If you are stuck in an enterable field because you do not want to enter any data in the field and Banner keeps prompting you that “Field must be entered or deleted first”, click on the Field pull-down menu and select Clear or click on the Record pull-down menu and select Clear or Remove to get out of the blank enterable field.

➢ Tip for entering today’s date in a date field – type the letter ‘t’ in the field and tab out of the field will populate today’s date in the field.

➢ A few notes about querying

   ● Capitalization matters. Data is matched against the search criteria exactly as you enter them.

   ● To clear a query and enter a new one, select Enter Query icon from the Tool Bar.
Conclusion

Let's review some of the things you learned in this training session.

You learned:

✓ that related forms are grouped together into Module menus, and Module menus are grouped together into the System menus
✓ the General Menu window is the starting point for navigating throughout the system
✓ about forms, the various blocks within a form and how to access them
✓ how to navigate within Banner by using the Pull-down Menu, the Tool Bar, the Options Menu and the keyboard functions
✓ how to find values using query forms and validation lists
✓ about wildcards and how to use them for your search criteria
✓ about QuickFlow and how to create and use them.
✓ how to create a personal menu
✓ how to set up user preference
✓ how to change your oracle password
✓ how to get more information about Banner from help functions and on-line documentation.

Last but not least, you learned how to exit Banner.

Congratulations and welcome to Bannerland!
# BANNER Navigation Mapping Sheet

<table>
<thead>
<tr>
<th>Function</th>
<th>Keystrokes</th>
<th>Icons</th>
<th>Pull-down Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Form</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Form/Rollback</td>
<td>Shift + F7</td>
<td>[ ]</td>
<td>File; Rollback</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Block</td>
<td>Ctrl + Page Down</td>
<td>[ ]</td>
<td>Block; Next</td>
</tr>
<tr>
<td>Previous Block</td>
<td>Ctrl + Page Up</td>
<td>[ ]</td>
<td>Block, Previous</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Item/Field</td>
<td>Ctrl + U</td>
<td>[ ]</td>
<td>Field; Clear</td>
</tr>
<tr>
<td>Duplicate Item/Field</td>
<td>F3</td>
<td>[ ]</td>
<td>Field; Duplicate</td>
</tr>
<tr>
<td>Next Item/Field</td>
<td>Tab or Enter</td>
<td>[ ]</td>
<td>Field; Next</td>
</tr>
<tr>
<td>Previous Item/Field</td>
<td>Shift + Tab</td>
<td>[ ]</td>
<td>Field; Previous</td>
</tr>
<tr>
<td>Delete Backward</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Character</td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Record</td>
<td>Shift + F4</td>
<td>[ ]</td>
<td>Record; Clear</td>
</tr>
<tr>
<td>Delete/Remove Record</td>
<td>Shift + F6</td>
<td>[ ]</td>
<td>Record; Remove</td>
</tr>
<tr>
<td>Duplicate Record</td>
<td>F4</td>
<td>[ ]</td>
<td>Record; Duplicate</td>
</tr>
<tr>
<td>Insert Record</td>
<td>F6</td>
<td>[ ]</td>
<td>Record; Insert</td>
</tr>
<tr>
<td>Next Record</td>
<td>[ ]</td>
<td></td>
<td>Record; Next</td>
</tr>
<tr>
<td>Previous Record</td>
<td>[ ]</td>
<td></td>
<td>Record; Previous</td>
</tr>
<tr>
<td>Next Set of Records</td>
<td>Page Down</td>
<td>[ ]</td>
<td>Query: Fetch Next Set</td>
</tr>
<tr>
<td>Previous Set of Records</td>
<td>Page Up</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td><strong>Query</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel Query</td>
<td>Ctrl + Q</td>
<td>[ ]</td>
<td>Query; Cancel</td>
</tr>
<tr>
<td>Count Query Hits/Search &amp; Display More Detail</td>
<td>Shift + F2</td>
<td>[ ]</td>
<td>Query; Count Hits</td>
</tr>
<tr>
<td>Enter Query</td>
<td>F7</td>
<td>[ ]</td>
<td>Query; Enter</td>
</tr>
<tr>
<td>Execute Query</td>
<td>F8</td>
<td>[ ]</td>
<td>Query; Execute</td>
</tr>
<tr>
<td>Exit with Value/Select</td>
<td>Shift + F3</td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td>Wild Card for Search</td>
<td>%</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save/Accept/Commit</td>
<td>F10</td>
<td>[ ]</td>
<td>File; Save</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl + Q</td>
<td>[ ]</td>
<td>File; Exit</td>
</tr>
<tr>
<td>Print</td>
<td>Shift + F8</td>
<td>[ ]</td>
<td>File; Print</td>
</tr>
<tr>
<td>List of Values</td>
<td>F9</td>
<td>[ ]</td>
<td>Help; List</td>
</tr>
<tr>
<td>XtenderSolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Error</td>
<td>Shift + F1</td>
<td>[ ]</td>
<td>Help; Display Error</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
<td>[ ]</td>
<td>Help; Help (Item Properties)</td>
</tr>
<tr>
<td>Show Function Keys</td>
<td>Ctrl + F1</td>
<td>[ ]</td>
<td>Help; Show Keys</td>
</tr>
</tbody>
</table>
## Glossary of Banner Terms

The following list describes the standard terms used within the Banner System:

<table>
<thead>
<tr>
<th>Terms</th>
<th>Definitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Box</td>
<td>A type of dialog box that pops up to notify you of a condition that may affect how you can enter information or the kind of information you can enter. It requires you to acknowledge the message before you can continue.</td>
</tr>
<tr>
<td>Application form</td>
<td>Form used to enter, update, or query information. (An application form usually will have the letter “A” in the third position of the form name.)</td>
</tr>
<tr>
<td>Block</td>
<td>An information area on a form usually separated by a solid line.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Exits you from an Option List, List of Values, Editor window, or Dynamic Help.</td>
</tr>
<tr>
<td>Clear Form Rollback</td>
<td>Clears all information and returns you to the first enterable field in the key information area. See also Rollback.</td>
</tr>
<tr>
<td>Commit</td>
<td>Saves all changes entered since the last time you saved. Also see Save.</td>
</tr>
<tr>
<td>Count Hits</td>
<td>In query mode, counts the number of records that meet the search criteria and displays that number in the Auto Hint line.</td>
</tr>
<tr>
<td>Count Query Hits</td>
<td>In query mode, counts the number of records that meet the search criteria and displays that number in the Auto Hint line. To retrieve records, select the Execute Query Function.</td>
</tr>
<tr>
<td>Dialog Box</td>
<td>A box containing information. Requires you to respond to it before you can continue.</td>
</tr>
<tr>
<td>Down</td>
<td>Use the &lt;DOWN ARROW&gt; key. Moves the cursor to the first enterable field in the next record, moves you lower on a List of Values or a pull-down list.</td>
</tr>
<tr>
<td>Pull-down List</td>
<td>A pull-down list shows three or more values for a field. Any field with a down arrow icon contains a pull-down list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays a window you can use to add, change, or delete text; especially useful in entering updating Dynamic Help.</td>
</tr>
<tr>
<td>Enter Query</td>
<td>Puts the form into query mode and lets you enter search criteria to see what information is already in the database. ENTER QUERY appears in the Status Line.</td>
</tr>
<tr>
<td>Execute Query</td>
<td>Execute query function searches the database and displays any records that match the search criteria.</td>
</tr>
<tr>
<td>Exit</td>
<td>From forms and windows, exits you out of the form or window. From menus, exits you out of the Banner system. From query mode, cancels the query and takes the form out of query mode.</td>
</tr>
<tr>
<td>Exit with Value</td>
<td>From a called form, returns you to the calling form and enters the highlighted value into the field that called the form. From a List of Values (LOV), returns you to the calling form and enters the highlighted value into the field that called the form.</td>
</tr>
<tr>
<td>Exit without Value</td>
<td>From forms and windows, exits you out of the form or window. From menus, exits you out of the Banner system. From query mode, cancels the query and takes the form out of query mode.</td>
</tr>
<tr>
<td>Field</td>
<td>Area in a form where you can enter, query, change information, or where existing information is displayed. Banner describes fields as either enabled, disabled, enterable, or display only.</td>
</tr>
</tbody>
</table>
### Glossary of Banner Terms – cont’d

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form</td>
<td>Window containing information blocks with various types of fields.</td>
</tr>
<tr>
<td>Inquiry Form</td>
<td>Form used to look up existing information on the database. Allow you to</td>
</tr>
<tr>
<td></td>
<td>view but not update. (An inquiry form usually has the letter “I” in the</td>
</tr>
<tr>
<td></td>
<td>third position of the form name.)</td>
</tr>
<tr>
<td>List of Values (LOV)</td>
<td>Displays a list of values for the current field if &lt;List of values&gt; appears</td>
</tr>
<tr>
<td></td>
<td>in the status line.</td>
</tr>
<tr>
<td>Menu</td>
<td>A list of options you can access with the mouse or keyboard.</td>
</tr>
<tr>
<td>Next Block</td>
<td>Means to move the cursor to the next information area (block) that has at</td>
</tr>
<tr>
<td></td>
<td>least one enterable field.</td>
</tr>
<tr>
<td>Next Field</td>
<td>The next enterable field in the current information area.</td>
</tr>
<tr>
<td>Next Record</td>
<td>Means to move the cursor to the first enterable field in the next record</td>
</tr>
<tr>
<td></td>
<td>of the current information area. If the cursor is in the last record, a</td>
</tr>
<tr>
<td></td>
<td>new record is created.</td>
</tr>
<tr>
<td>Object</td>
<td>An object can be a form, job, menu or QuickFlow used in Banner.</td>
</tr>
<tr>
<td>Pop-Up Window</td>
<td>Dialog box, alert box, or list of values that appear in a separate window.</td>
</tr>
<tr>
<td>Previous Block</td>
<td>The previous information area that has at least one enterable field. If</td>
</tr>
<tr>
<td></td>
<td>the previous area is another window, then that window is opened.</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Means to move the cursor to the previous enterable field in the current</td>
</tr>
<tr>
<td></td>
<td>information area.</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Means to move the cursor to the first enterable field in the previous</td>
</tr>
<tr>
<td></td>
<td>record.</td>
</tr>
<tr>
<td>Query Form</td>
<td>Form used to look up existing information on the database. (A query form</td>
</tr>
<tr>
<td></td>
<td>usually has the letter “Q” in the third position of the form name.)</td>
</tr>
<tr>
<td>QuickFlow</td>
<td>A set of forms that are linked together in order to help you complete a</td>
</tr>
<tr>
<td></td>
<td>process within Banner. When you use QuickFlow, it opens the first form in</td>
</tr>
<tr>
<td></td>
<td>the set and the next form is automatically opened until the process is</td>
</tr>
<tr>
<td></td>
<td>completed.</td>
</tr>
<tr>
<td>Record</td>
<td>All information displayed in the window for an item.</td>
</tr>
<tr>
<td>Rollback</td>
<td>From an application or inquiry form, clears all information and returns</td>
</tr>
<tr>
<td></td>
<td>you to the first enterable field in the key information area. Rollback is</td>
</tr>
<tr>
<td></td>
<td>a standard button and appears on most forms. From validation forms,</td>
</tr>
<tr>
<td></td>
<td>rollback will return you to the first enterable field on the form. From a</td>
</tr>
<tr>
<td></td>
<td>query form it will return you to the first enterable field on the calling</td>
</tr>
<tr>
<td></td>
<td>form. Rollback is also referred to as Clear Form. See also Clear Form</td>
</tr>
<tr>
<td></td>
<td>Rollback.</td>
</tr>
<tr>
<td>Save</td>
<td>Means to save all changes entered. Also see Commit.</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>The process of moving down repeating records or lists of information that</td>
</tr>
<tr>
<td></td>
<td>cannot all be displayed in one window.</td>
</tr>
<tr>
<td>Select</td>
<td>Choose an item by highlighting it or clicking it with mouse.</td>
</tr>
<tr>
<td>Show Keys</td>
<td>Display the list of keyboard options.</td>
</tr>
<tr>
<td>Up</td>
<td>Use the &lt;UP ARROW&gt; key. Moves the cursor to the first enterable field in</td>
</tr>
<tr>
<td></td>
<td>the previous record, moves you upward on a List of Values or pull-down</td>
</tr>
<tr>
<td></td>
<td>list.</td>
</tr>
<tr>
<td>Validation Form</td>
<td>Form used to define the values that can be entered in specified fields on</td>
</tr>
<tr>
<td></td>
<td>application forms. (A validation form will have the letter “V” in the</td>
</tr>
<tr>
<td></td>
<td>third position of the form name.</td>
</tr>
<tr>
<td>Window</td>
<td>Displays an information area.</td>
</tr>
</tbody>
</table>
Naming Conventions

Here are some handy tables that show you the meanings of the first three letters in each Banner form, job, or table.

The first table displays the letters that can occupy Position 1 and the Banner systems they represent.

*Note: Georgia State University is using the following Banner systems.*

<table>
<thead>
<tr>
<th>Position 1</th>
<th>Banner System</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>General</td>
</tr>
<tr>
<td>R</td>
<td>Financial Aid</td>
</tr>
<tr>
<td>S</td>
<td>Student</td>
</tr>
<tr>
<td>T</td>
<td>Accounts Receivable</td>
</tr>
<tr>
<td>W</td>
<td>Georgia State Applications.</td>
</tr>
<tr>
<td>Y</td>
<td>Reserved for Client Applications that may co-exist with Banner.</td>
</tr>
<tr>
<td>Z</td>
<td>Georgia Enhancements from Board of Regents (BOR)</td>
</tr>
</tbody>
</table>

The following tables show you the meanings of the second and third letters in each Banner system. The title of each table displays the letter in Position 1, followed by the name of the Banner system.

**Position 1  G   General**

<table>
<thead>
<tr>
<th>Position 2</th>
<th>Module</th>
<th>Position 3</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Event Management</td>
<td>A</td>
<td>Application Form</td>
</tr>
<tr>
<td>J</td>
<td>Job Submission</td>
<td>B</td>
<td>Base Table/Batch COBOL Process</td>
</tr>
<tr>
<td>L</td>
<td>Letter Generation</td>
<td>I</td>
<td>Inquiry Form</td>
</tr>
<tr>
<td>O</td>
<td>Overall</td>
<td>O</td>
<td>Online COBAL Process</td>
</tr>
<tr>
<td>P</td>
<td>Purge</td>
<td>Q</td>
<td>Query Form</td>
</tr>
<tr>
<td>S</td>
<td>Security</td>
<td>R</td>
<td>Rule Table/Repeating Table/Report/Process</td>
</tr>
<tr>
<td>T</td>
<td>Validation Form/Table</td>
<td>T</td>
<td>General Maintenance/Temporary Table</td>
</tr>
<tr>
<td>U</td>
<td>Utility</td>
<td>V</td>
<td>Validation Form/Table/View</td>
</tr>
<tr>
<td>W</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X</td>
<td>Cross Product</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Appendix C
### Naming Conventions – cont’d

<table>
<thead>
<tr>
<th>Position 1</th>
<th>Position 2</th>
<th>Module</th>
<th>Position 3</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>B</td>
<td>Budgeting</td>
<td>A</td>
<td>Application Form</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>Record Creation</td>
<td>B</td>
<td>Base Table</td>
</tr>
<tr>
<td></td>
<td>E</td>
<td>Electronic Data Exchange</td>
<td>I</td>
<td>Inquiry Form</td>
</tr>
<tr>
<td></td>
<td>F</td>
<td>Funds Management</td>
<td>P</td>
<td>Process/Report</td>
</tr>
<tr>
<td></td>
<td>H</td>
<td>History and Transcripts</td>
<td>R</td>
<td>Rule Table/Repeating Table/Report/Process</td>
</tr>
<tr>
<td></td>
<td>J</td>
<td>Student Employment</td>
<td>T</td>
<td>Temporary table</td>
</tr>
<tr>
<td></td>
<td>L</td>
<td>Logging</td>
<td>V</td>
<td>Validation Form/Table/View</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>Need Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>O</td>
<td>Common Function</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>P</td>
<td>Packaging and Disbursements</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>R</td>
<td>Requirements Tracking</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>S</td>
<td>Student System Shared Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>T</td>
<td>Validation Form/Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>W</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Z</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Naming Conventions – cont’d

### Position 1: S  Student

<table>
<thead>
<tr>
<th>Position 2</th>
<th>Module</th>
<th>Position 3</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Admissions</td>
<td>A</td>
<td>Application Form</td>
</tr>
<tr>
<td>C</td>
<td>Catalog</td>
<td>B</td>
<td>Base Table</td>
</tr>
<tr>
<td>E</td>
<td>Support Services</td>
<td>I</td>
<td>Inquiry Form</td>
</tr>
<tr>
<td>F</td>
<td>Registration/Fee Assessment</td>
<td>P</td>
<td>Process</td>
</tr>
<tr>
<td>G</td>
<td>General Student</td>
<td>Q</td>
<td>Query Form</td>
</tr>
<tr>
<td>H</td>
<td>Grades/Academic History</td>
<td>R</td>
<td>Rule Table/Repeating Table/Report/Process</td>
</tr>
<tr>
<td>I</td>
<td>Faculty Load</td>
<td>V</td>
<td>Validation Form/Table/View</td>
</tr>
<tr>
<td>L</td>
<td>Location Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>CAPP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>Overall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Person</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>Recruiting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>Schedule</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Validation Form/Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>U</td>
<td>Utility</td>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Position 1: T  Accounts Receivable

<table>
<thead>
<tr>
<th>Position 2</th>
<th>Module</th>
<th>Position 3</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Finance Accounts Receivable</td>
<td>A</td>
<td>Application Form</td>
</tr>
<tr>
<td>G</td>
<td>General Accounts Receivable</td>
<td>I</td>
<td>Inquiry Form</td>
</tr>
<tr>
<td>O</td>
<td>Overall</td>
<td>P</td>
<td>Process</td>
</tr>
<tr>
<td>S</td>
<td>Student Accounts Receivable</td>
<td>Q</td>
<td>Query Form</td>
</tr>
<tr>
<td>T</td>
<td>Validation Form/Table</td>
<td>R</td>
<td>Report</td>
</tr>
<tr>
<td>U</td>
<td>Utility</td>
<td>V</td>
<td>Validation Form/Table</td>
</tr>
<tr>
<td>W</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td>Reserved for client forms or modules</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Positions 4, 5, 6, and 7 uniquely identify the form, report, job, and table.

For more information about Banner naming conventions, see Chapter 2, Using Banner, in any of the SCT Banner user manuals.
Answer Key for Review

Review – page 7
1. b 2. b 3. c

Review – page 18
1. d 2. c

Review – page 25
1. Tab, Keyboard function, Button icon, and Pull-down menu
2. c 3. b 4. c

Review – page 27
1. c 2. b 3. d

Review – page 42
1. Search in a dedicated query form and search within a key block
2. c
3. To narrow the search
4. Once to exit the query function, then once again to exit the form
5. Banner Bookshelf on the General Menu Window